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1 BEFEEHY 1.1 RGN

1@1#%1%1"@

1.1 RGN

Gowin_EMPU_M3, G —=2igit, Wik 1-1 fos.
1-1 RG34

MCU Core System AHB Bus System APB Bus System

IROI15:0]

Embedded
I GPID
= wic NVIC P“’c‘;j“' bk Trace el
Macrocell

UARTD

UART1
Ethernet
Debug Serial Tirmerd
- Memaory
Access y " - Wire  f——
Port Pratection Unit Viewer DOR3
1 I Timerl
SPI-Flash
Flash Data AHB
Patch | [Watchpoints| Bridge lHEZAPE
- e

AHBZ
\AL I xtensior

B BBA[H0E0

Bus Martix ZC
Master
Code SRAM and Peripheral
Interface Interface =)
Master
sD-Card
Instruction Data
Memory Memory 7FES
xtension

%—2, MCU Core System, fu#i ARM Cortex-M3 Processor Core.
Instruction Memory A1 Data Memory, UL Peripheral Interface.

%%, AHB Bus System, 315 GPIO. Ethernet. DDR3 Memory.
SPI-Flash 1 AHB2 Extension.

% =%, APB Bus System, fiff UARTO. UART1. TimerO. Timer1.
WatchDog. RTC. 12C Master. SPI Master. SD-Card GiZRAASZE:)
APB2 Extension.
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1 BEFEEHY

1.2 REGUFHIE

1.2 RG4S

Gowin_EMPU_M3, A3 =% T ARG 4HM:
MCU Core System T % %;

AHB Bus System T &4t

APB Bus System T #4;

1.2.1 MCU Core System F %%t
SRR

IPUG923-1.1

ARM architecture v7-M Thumb2 154 822¥8), S HF 16-bit 1 32-bit 54
£

¥ MPU (Memory Protection Unit)

S FF WIC (Wakeup interrupt Controller)
S F¥ Bit-banding

¥ sleep mode HUFE B, [FIKRGAIhFE
e BT S5 A TR I 4R R A
SCREEHR AN 2 /i g =X
RGN E I 40MHz LR

NVIC (Nested Vector Interrupt Controller)

f’eft 16 M RIS S, TP E Y R e IR
SCF 256 Wt e 25
BEN WAL BRI B B IRAF AL BRI, IR B RN B SR RS

SCRFR A ) AT C & -

No debug

Minimum debug

Full debug minus DWT (Data Watchpoint and Trace)
Full debug plus DWT

SCRFIAAE AT L A

Serial Wire

JTAG and Serial Wire

FF Trace F L & :

No trace

Standard trace. ITM (Instrumentation Trace Macrocell and DWT (Data
Watchpoint Trace) , No ETM (Embedded Trace Macrocell)

Full trace. ITM, DWT and ETM
High trace. ITM, DWT, ETM and HTM (AHB Trace Macrocell)
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1 BEFEEHY

1.3 &% I

Memory
Instruction Memory: 15417t #%, Size 7] Aic & A 16KB. 32KB. 64KB

5 128KB, X FF bootload HI4A1E LA N

Data Memory: %i#a{7fit#%, Size nJLABECE N 16KB. 32KB. 64KB 5k

128KB.

1.2.2 AHB Bus System F&H %t

AHB S A AN 4%
GPIO

Ethernet

DDR3 Memory
SPI-Flash

AHB2 Extension

1.2.3 APB Bus System F& %t

1.3 Z&Stiw O

IPUG923-1.1

APB S 2 AR 4%
UARTO0/1

Timer0/1

WatchDog

RTC

I2C Master

SPI Master

APB2 Extension

Gowin_EMPU_M3 &% [ 5E X, W3k 1-1 fiss.

® 1-1 RGisOEX
2 /o | f%E | fEk R RN
HCLK in 1 ARG b -
hwRstn in 1 EX W=D -
LOCKUP out |1 M #ZlockupR 2 -
HALTED out |1 M #%halt debugih 7 -
JTAG_3 inout | 1 IR TRSTN
JTAG_4 inout | 1 Wik OINC
JTAG 5 inout | 1 Wik DI
JTAG_6 inout | 1 Wik OINC DAP
JTAG 7 inout | 1 Wi I TMS/SWDIO
JTAG_8 inout | 1 ik THOLDN
JTAG 9 inout | 1 R O TCK/SWCLK
JTAG_10 inout | 1 Wi 1SI01
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1 BRI 1.3 R4 1
B /o | fi%E | fEk I @ s e
JTAG 11 inout | 1 Wi INC
JTAG_12 inout | 1 Wik OSCLK
JTAG_13 inout | 1 Wik O TDO/SWO
JTAG_14 inout | 1 WA SI00
JTAG_15 inout | 1 Wik OSRSTN
JTAG_16 inout | 1 Wik HCS
JTAG_17 inout | 1 ik#E LINC
JTAG_18 inout | 1 Wik O WPN
IRQ in [15:0] | H P hibrab 25 5 NVIC
GPIO inout | [15:0] | i FH %\ 4 Hi o GPIO
UARTORXD in 1 UARTO#E A 1
UARTOTXD out |1 UARTO & % i 1 UARTO
UART1RXD int 1 UART 142 i 1

‘ UART1
UART1TXD out |1 UART LA 1% % [
TIMEROEXTIN in 1 TimerQ4M i H Timer0
TIMER1EXTIN in 1 Timer1 755 Timerl
RTCSRCCLK in 1 RTCH} 9§ 32.768KHz RTC
SCL inout | 1 AT IR 12C
SDA inout | 1 AT H R Master
MOSI out |1 B & S NG E PN
MISO in 1 B SN Nl SPI
SCLK out |1 I Master
NSS out |1 NS ILEREE S
RGMIl_TXC out |1 RGMIK A I
RGMII_TX_CTL out |1 RGMIK %45
RGMIl_TXD out |[3:0] RGMIUK IE 45 Ethernet
RGMII_RXC in 1 RGMII IR B RGMII
RGMII_RX_CTL in |10 RGMIH: 12 i Interface
RGMII_RXD in [3:0] RGMIHZ S A5
GTX_CLK in 1 RGMII 125MHzH g A\
GMIl_RX_CLK in 1 GMINEZ ST
GMIl_RX_DV in 1 GMIIFZ A R
GMIl_RXD in [7:0] GMIIE I E
GMII_RX_ER in 1 GMIZ A5 gtlcltlelmet
GTX_CLK in 1 GMII 125MHzH hégi A\ Interface
GMIl_GTX_CLK out |1 GMIIR 3% gl
GMII_TXD out |[[7:0] | GMIIK %%
GMII_TX_EN out |1 GMIIK % flifE

IPUG923-1.1
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1 BRI 1.3 ARG 1
B4 /o | fi%E | fEk T I Ak
GMII_TX_ER out |1 GMIIK % 1%

MIl_RX_CLK in 1 MUY b
MII_RXD in [3:0] MIZEUSCE
MII_RX_DV in 1 MU fi g
MII_RX_ER in 1 M
MII_TX_CLK in |1 ML 251 4 memet
MII_TXD out |[3:0] | MIKIEEHE Interface
MIl_TX_EN out |1 MIIK %S g
MIl_TX_ER out |1 MIUA I £ iR
MIl_COL in 1 MU RAE 5
MIl_CRS in 1 MIEEAE 5
MDC out |1 B T 3 N e

_ Ethernet
MDIO inout | 1 BB TE B
DDR_CLK_| in 1 50MHzH g A
ere o oM Tout |1 WA LSER S
DDR_ADDR_O out | [15:0] | Rowittik. Columnitiht
DDR_BA O out | [2:0] Bankihhi:
DDR_CS N_O out |1 FrikfES
DDR_RAS N_O out |1 RowHi bl %815 5
DDR_CAS N_O out |1 ColumnibtitikiE(E 5
DDR_WE_N_O out |1 Row 5 i fit
DDR_CLK_O out |1 %’%ﬁééDDRs SDRAMHIEE!{E | pDR3
DDR_CLK_N_O out |1 5DDR_CLK_O#HEMES
DDR_CKE_O out |1 DDR3 SDRAMI £ GE {5 5
DDR_ODT_O out |1 W AFA5 7 S P PH A2 ]
DDR_RESET_N_O |out |1 DDR3 SDRAME {5 5
DDR_DQM_O out |[[1:0] | DDR3 SDRAM¥#E Ftikifs =
DDR_DQ _IO inout | [15:0] | DDR3 SDRAM%#f
DDR_DQS_IO inout | [1:0] DDR3 SDRAMZ i i% i {5 5
DDR_DQS_N_IO inout | [1:0] LDDR_DQS_IOH W Z= /55
EILASH_SPI_HOLD inout | 1 NG
FLASH_SPI_CSN inout | 1 ME R IR S
FLASH_SPI_MISO | inout | 1 N E S PNINE SPI-Flash
FLASH_SPI_MOSI |inout | 1 F AR HINEZHAN
FLASH_SPI_WPN |inout |1 NC
FLASH_SPI_CLK inout | 1 {5 =
APB2PSTRB out |[3:0] | APB2PSTRB APB2

IPUG923-1.1
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1 BEFEEHY

1.4 AL RIRG T

14 ARG HIRGT

IPUG923-1.1

RN /o | i | ik BIVET RN

APB2PPROT out [2:0] APB2 PPROT Extension

APB2PSEL out 1 APB2 PSEL

APB2PENABLE out 1 APB2 PENABLE

APB2PADDR out [31:0] | APB2 PADDR

APB2PWRITE out 1 APB2 PWRITE

APB2PWDATA out [31:0] | APB2 PWDATA

APB2PRDATA in [31:0] | APB2 PRDATA

APB2PREADY in 1 APB2 PREADY

APB2PSLVERR in 1 APB2 PSLVERR

APB2PCLK out 1 APB2 PCLK

APB2PRESET out 1 APB2 RESET

AHB2HSEL out 1 AHB2 HSEL

AHB2HADDR out [31:0] | AHB2 HADDR

AHB2HTRANS out [1:0] AHB2 HTRANS

AHB2HWRITE out 1 AHB2 HWRITE

AHB2HSIZE out [2:0] AHB2 HSIZE

AHB2HBURST out [2:0] AHB2 HBURST

AHB2HPROT out [3:0] AHB2 HPROT

AHB2HWDATA out |[31:.0] | AHB2 HWDATA AHB2

AHB2HMASTLOCK | out 1 AHB2 HMASTLOCK Extension

AHB2HREADYMUX | out 1 AHB2 HREADYMUX

AHB2HRDATA in [31:0] | AHB2 HRDATA

AHB2HREADYOUT | in 1 AHB2 HREDAYOUT

AHB2HRESP in [21:0] AHB2 HRESP

AHB2HMASTER out [3:0] AHB2 MASTER

AHB2HCLK out 1 AHB2 HCLK

AHB2HRESET out 1 AHB2 RESET

Gowin_EMPU_M3 R4 # ST, 1% 1-2 fos.
® 12 RGHRGH
S Resources || y1s | Registers | BSRAMs ,?A‘zsros
I\P/IeCriLrJ)hCe(;;?sSystem Minimum and No 17138 | 2245 16 >
I\P/IeCriL;k?ec;;TsSystem Default and No 29732 | 4634 64 >
I\P/IeCriL;k?ec;;TsSystem Maximum and No 25290 | 5571 128 2
m;gm%%rqe System and All Peripherals 37345 | 12981 111 5
6(27)




2 e iiAs 2.1 REPEIRIR

2@#&%%&

2.1 BHIFE

DK-START-GW2A55 V1.3: GW2A-LV55P(G484C8/I7

2.2 U

Gowin_V1.9.8Beta & L FhR 4.

2.3 IP Core Generator

Gowin =JE¥ 4 1#) IP Core Generator, fT-Ht & flp=4
Gowin_EMPU_M3 FEf i},

2.4 Programmer
Gowin & H 4+ Programmer, F T A5 SO A1 8 2w A2 — 12 1) BIN

SO
Programmer B A{EH 777%, 1§23 SUG502, Gowin Programmer H
FEF .
2.5 &itHiz

Gowin_EMPU_M3 & A

1. P Core Generator i & MCU Core System.AHB Bus System #1 APB
Bus System, 7#E Gowin EMPU_M3 %11, SN 2407 TIE;

2. S5tk Gowin_ EMPU_M3 Top Module, S AR PR, @A A
M5 Gowin. EMPU_M3 Top Module;

VIER LA 7 29 3 5

GowinSynthesis 56, A2 B2 A

Place & Route i Jaffik, A RASi S

Programmer #5314 %) GW2A-55/GW2A-55C/GW2AN-55C.

o a0 A~ W
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http://cdn.gowinsemi.com.cn/SUG502.pdf

3 LAEMRAR 3.1 T

TR

3.1 SIETI=E
3.1.1 81 TIE

WA I Gowin =4, S HAE “File > New... > FPGA Design
Project”, £l FPGA Design Project, 1 3-1 T/~
[#l 3-1 1|3 FPGA Design T2

w

‘
T g o
b v Si

Recent Projects:

W New 7 *

~ Projects )

=\ FPGA Design Project

~ Files
A} Verilog File
|& VHDLFile r
_\-J Physical Constraints File

& Timing Constraints File v

Create a FPGA design project.
You will be able to add or create RTL sources, run synthesis,
place 8 route, and program your device.

Manual for LittleBee Manual for Arora
Start Page

3.1.2 R ETIERHRFEEE
M TR, B8 TRKEZ, WK 32 Fix.

IPUG923-1.1 8(27)




3 TR 3.1 QTR

& 3-2 R L RERMRMEE

W Project Wizard x

Project Name
E}> Project Name
Select Device Enter a name for your project, and specify a directory where the project will be stored. The directory will be

created if it doesn't exist.
Summary

Name: ‘gowin_empu_mS ‘

Create in: ‘F:\ |

[ Use as default project location

ext = Cancel

3.1.3 iEFFR4E

1%#¢ “Series”. “Device”. “Package”. “Speed” #l “Part Number”,
ﬁu@ 3'3 Fﬁﬂ—_‘—\‘o

LU R T RAZ it N, s ps:
Series: GW2A

Device: GW2A-55C

Package: PBGA484

Speed: C8/I7

® Part Number: GW2A-LV55PG484C8/17

[ 3-3 ik

W Project Wizard b4

Select Device
Project Name

E» Select Device Specify a target device for your project
Summary Filter
Series: | GW2A | Device: GW2A-55C -
Package: PBGA484 -
Speed: Cai7 -

Part Number Device Package Speed  Voltage 10 LuUT Fi
GW2A-LVS5PGABACB/I7 GW2A-55C PBGAdB4 | CB/IT 54720

= Back Cancel

g

IPUG923-1.1 9(27)




3 TR

3.2 fffF it

3.14 SR L2602

ik 3-4 R, SER LRI .
B 34 SERL T2t

W Project Wizard x
Summary
Project Name
Select Device Project
E?) EumEr Name: gowin_empu_m3

Directory: F:i
Source Directory: Fi\gowin_empu_m3\src
Implementation Directory: F:\gowin_empu_m3yimpl

Device
Part Number: GW2A-LV55PG4B4CE/I7
Series: GW2A
Device: GW24-55C
Package: PBGA434
Speed: C8/17

= Back Cancel

3.2 Bt

IPUG923-1.1

i F IP Core Generator /%4 Gowin_ EMPU_M3 fifi %11

L EAEE “Tools > IP Core Generator” % T E.#~ IP Core Generator
“ &% 7, #TFF IP Core Generator.

1%E# “Soft IP Core > Microprocessor System > Soft-Core-MCU >
Gowin_EMPU_M3 1.0”, #n& 3-5 ffios.

3-5 1%#F Gowin_EMPU_M3

& GOWIN PG

g M i Gowin_EMPU_M3
Information

Type: Gowin_EMPU_M3
Vendor: GOWIN Semiconductor

Summary

Gowin_EMPU_M3 indudes MCU Core Syste

Desi Proces by Design Summary
Consol 8%
c Mes:

I Gowin_EMPU_M3, ZR&i4itytni 3-6 fiis.

f1F5“MCU Core System”. “AHB Bus System” i1 “APB Bus System”
“HTRAEE.

10(27)




3 TR

3.2 it

& 3-6 Z5E4E

s Gowin EMPU M3

File

Device: | GW2A-55C

| Part Number: [GW2A-LvS5PG4B4ACE/I7 ]

Create In: |FAgowin_empu_m3\sre\gowin_empu_m3

Language: | Verilog

v | Synthesis Tool: | GowinSynthesis

MCU Core System

IRQ[15:0]

Bus Martix

SRAM and Peripheral
Interface

AHB Bus System APB Bus System
m
UART1
Ethernet
Timerd
— —3
AHB VistchDog
Bridge larB2aPe
AHBZ Bridge
= =]
SD-Card
T
[Bxtension

3.2.1 MCU Core System ECE

MCU Core System ¥ & il &L,

Wk 3-1 ffizse

%z 3-1 MCU Core System it B % 1R

e & e T3

ik

Enable User Interrupts

JFRL6 P R IR BRI  ie R TAR B T e s
BRIA KA o

Enable MPU

{fi¢Memory Protection Unit;

BRI RE -

Enable WIC

i fEWakeup Interrupt Controller;
BRI RE

Enable Bit-banding

fii it Bit-banding;
BRI RE

IRQ Priority Level
Width

e PR e AL B, HUAE G H 3~85
ENAGISIEVSER

WIC Lines

fi. & Wakeup Interrupt Controller Lines, B it FE3~243;
BRAUE A3,

Debug Level

PC B RS R

No debug

Minimum debug

Full debug minus DWT
Full debug plus DWT

2L ilFull debug plus DWT

Trace Level

Hic B IR IR R R

No trace

Standard trace. ITM and DWT, No ETM

Full trace. ITM, DWT and ETM

High trace. ITM, DWT, ETM and HTM

2L\ Standard trace. ITM and DWT, No ETM

Debug Interface

P B AR

IPUG923-1.1
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3 TR

3.2 it

Hie B 36 10

Eitipay

Serial wire
JTAG and serial wire
ERINITAG and serial wire

Instruction Memory
Size

HUE16KB. 32KB. 64KBE{128KB;
2R1\64KB.

Initialization File Path

bootload ¥ UG8 SCAF 842, FT F4hSPI-Flash 85 3l

Data Memory Size

HU{Ei16KB. 32KB. 64KBE{128KB;
ZRIA64KB.

X MCU Core Systm, #TH MCU Core System FC ik, 45
Configuration. Debug-. Instruction Memory 1 Data Memory i & %17 .

Configuration

1% Configuration fic & i%& I, Wk 3-7 s, 7] LA & User Interrupts.
MPU. WIC. Bit-banding. IRQ Priority Level Width #1 WIC Lines.

3-7 Configuratio

MCU Core Systsm ? pe
MCU Core System 5 7)
Gowin EMPU_M3 is built on a high performance processor core Cortex-M3, with a 3-stage pipeline
Harvard architecture, making it ideal for demanding embedded applications, and is integrated into
Gowin FPGA.
MCU Core System includes MCU Core, Instruction Memery and Data Memory.
In MCU Core, upts,

£
El

bit-banding,
In Instruction Mer
path and data memory size.

N NN N NN N N

Gowin EMPU M3

Options

Configuration ~ Debug  Instruction Memory — Data Memory

[ Enable User Interrupts

Enable MPU

Enable WIC

Enable Bit-banding

IRQ Priority Level Width: [3 [2]3 ~ )

WIC Lines: [3 -~ 243)

® User Interrupts it &
- Gowin_EMPU_M3 &4t 16 /N /il b #i55, HTH P w&d
J&& rp BT AL B T AE
- ik $% Enable User Interrupts, Ml Gowin_ EMPU_M3 Sz £fH f
WrAbHE, HWIASCERE .

- BRI,
® MPU it &

- W% Enable MPU, Il Gowin_ EMPU_M3 3 #F MPU, %A

SCFFo

IPUG923-1.1
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3 TR

3.2 it

IPUG923-1.1

- BUAikEe.
® WICTiLHE
- W%k Enable WIC, N Gowin. EMPU_M3 32 #F WIC, H AL
S
- BRNIEHE.
® Bit-banding it &
- W%k Enable Bit-banding, N Gowin_ EMPU_M3 37 £f
Bit-banding, 7M.
- Bk,
® |IRQ Priority Level Width fit &
- BCE PR TE, BUETIHE 3~8, W LASCRF 8~256 Z¢ LSt
REL .
- BilHN 3.
® WIC Lines it &
- fic® WIC Lines, HUHEH 3~243.
- BRIAA 3.
Debug

1% Debug It B L 1, 4l 3-8 Firzw, 1l LARC & Debug Level. TraceLevel
F1 Debug Interface.

3-8 Debug

MCU Core System ? X

MCU Core System &

Gowin EMPU_M3 is built on a high performance processor core Cortex-M3, with a 3-stage pipeline
Harvard architecture, making it ideal for demanding embedded applications, and is integrated into
Gowin FRGA.

MCU Core System includes MCU Core, Instruction Memery and Data Memory.

In MCU Core, user can configure external user interrupts, MPU, WIC, IRQ priarity level width, WIC lines,
bit-banding, debug level, trace level and debug interface.

In Instruction Memory and Data Memory, user can configure instruction memary size, initialization file
path and data memory size.

Options
ma
G 3 Configuration ~ Debug  Instruction Memory ~— Data Memory
e n Debug Level
e 1 (O No debug O Full debug minus DWT
e O Minimum debug @ Full debug plus DWT
— ] b
mc_13
- Trace Level
G 15 O Ne trace O Full trace. ITM, DWT and ETM

@® Standard trace. ITM and DWT, No ETM O High trace. ITM, DWT, ETM and HTM

ERRREERERRREERERE

Debug Interface

O Serial wire
Gowin EMPU M3

@® JTAG and serial wire

® Debug Level it &
BB WX R AV ReEH, .

13(27)
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-  No debug

- Minumum debug

- Full debug minus DWT

- Full debug plus DWT

!

ERIA Full debug plus DWT.

Trace Level fit &

MCE PRER RATIRESE R, BA:

-  No trace

- Standard trace. ITM and DWT, No ETM
- Full trace. ITM, DWT and ETM

- High trace. ITM, DWT ETM and HTM
!

R\ Standard trace. ITM and DWT, No ETM.
Debug Interface Fit &

Bo B A 2R, B

- Serial wire

- JTAG and serial wire

!

2R\ JTAG and serial wire.

Instruction Memory

% Instruction Memory BC B LI, Wikl 3-9 frr, 7] LAECE Instruction

Memory Size # Initialization File Path.
3-9 Instruction Memory

MCU Core System ? X

MCU Core System &

Gowin_EMPU_MS3 is built on a high performance processer core Cortex-M3, with a 3-stage pipeline
Harvard architecture, making it ideal for demanding embedded applications, and is integrated into
Gowin FPGA,

mory and Data Memory.

s, MPU, WIC, IRQ priority level width, WIC lines,

igu
bit-banding, d race level an ce.
In Instruction Memory and Data Memaory, user can configure instruction memory size, initialization file
jure path and data memary size.
mas

TG 4

MG 5

Options
G 3 Configuration ~ Debug  Instruction Memory  Data Memory

e o Instruction Memory Size: |64KB

Initialization File Path: | Figowin_empu_m3\bootloader

s 12

G 14

G 15

G 16

s 17

N NN NN NN NN

G 18

Gowin EMPU M3

Cancel
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® Instruction Memory Size fit &
it & Instruction Memory Size, 7] LABC & 4 16KB.32KB.64KB 5k 128KB.
ERIN N 64KB.
® |Initialization File Path fi &
B & bootload ¥k M #64%, FHT 4k SPI-Flash F#UE8 7. ]
PEAF K Instruction Memory Size, JHEAF bootload 445, N
SRR,
- 4B Instruction Memory Size it &  16KB, 1] Initialization File Path
TN AFFE & T HALH INSMEM_Size_16KB bootload #1441t 3£
- 4B Instruction Memory Size it & 5y 32KB, 1] Initialization File Path
InE AT & T EA R INSMEM_Size 32KB bootload #J4atk S 44

- W& Instruction Memory Size fit. & 5 64KB, Il Initialization File Path
Ing AT & T AL INSMEM_Size 64KB bootload #J#H4k 3014

- % Instruction Memory Size Bt & 128KB, N Initialization File
Path In#k kI & T H ALK INSMEM_Size 128KB bootload #1%4
s
!
Instruction Memory Initialization Path 5 ANHIE%1E, AREAH LARLT iy & S0 e 4%
Data Memory
1% ¥ Data Memory Bt & & 5, 41 & 3-10 s, A LUAC & Data Memory
Size.
3-10 Data Memory

MCU Core System ? X

MCU Core System o

racessor core Cortex-M3, with a 3-stage pipeline
ing embedded applications, and is integrated into
Memoary and Data Memory.
ernal user interrupts, MPU, WIC, IRQ priority level width, WIC lines,
ce level and debug interface.
Lockup (—e ser can configure instruction memory size, initialization file
wwwwww — path and data memaory size.
TG 3
ITNG 4 [
ITAG 5
ITG 6 -
- Options
TG 7 -
e nie Configuration  Debug  Instruction Memory  Data Memory
ITG 3 -
46,10 e Data Memory Size: |64KB -
ITAG 11 e
TG 12 (-
" 14 13
ITAG 14
ITAG 15 (e
ITAG 15 rH-
TG 17
ITAG 18 -
Gowin EMPU M3
Cance
. N N N
fic & Data Memory Size, 7] UAFCE N 16KB. 32KB. 64KB &\ 128KB.
% N ) Ay
RN 64KB.

IPUG923-1.1 15(27)
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3.2.2 AHB Bus System EL &

AHB Bus System T R4 E LT, Wk 3-2 s
% 3-2 AHB Bus System Bt 2 %R

i e 10 Eip
e GPIO
Enable GPIO B B
{fifit Ethernet
Enable Ethernet BR K b
Interface Ethernet 1L 4% Interface (RGMII/GMII/MII)
RN RGMII
RGMII input delay
RGMII Input Delay BRE N 100
. MIIM clock divider
MIIM Clock Divider By 20
fii i DDR3 Memory
Enable DDR3 B A
Enable SPI-Flash ffi e SPI-Flash T#IHEA Memory . 5. HERT)fE
BRNdRE
A
Enable AHB2 Extension ﬁfﬁg(g’z et

GPIO Bt &

T H GPIO, wmfLLEFEACE GPIO, K 3-11 fis.
IR % Enable GPIO, ] Gowin_ EMPU_M3 ¥ GPIO, BRil kM.
3-11 GPIO B0 B

GPIO ? X
Rl
GPIO 5]
The MCU core system of Gowin_EMPU_M3 interacts with GPIO black through
o AHB bus.The GPIO block interconnects with FPGA Fabric where user
ole implements general purpose I/O functions. This AHB GPIO is a general
o purpase |0 interface unit and provides a 16-bit I/O interface.
e
s
St
— e e
v .
| . Options
: Enable GPIO
e
.. s
e
.
St
Tlew
pove
o
MAU M
Conce
Ethernet B0 &

M AT Ethernet, 7] LLIAFEACE Ethernet, T 3-12 fior.,

® N3kt Enable Ethernet, Il Gowin_ EMPU_M3 37 £f Ethernet, ZRik
KMo

® IR A ILFE Enable Ethernet, IR UIAECE Interface. RGMII Input
Delay. MIIM Clock Divider.

IPUG923-1.1 16(27)
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- %P Interface, TTLLEFEACE RGMIL. GMII. MII 8% GMI/MII, %k
I RGMII,

- % Interface L& N RGMII, NATLLiEFERCE RGMII Input Delay,
ERINE N 100,
- 1+ MIIM Clock Divider, 7] LPABCE MIIM Clock Divider, ERiIAME N
20,
- % Interface ¥ RGMII 58 GMII, Nl 1 GTX_CLK 258 A
125MHz I8P N o
3-12 Ethernet it &

Ethernet 4 X
R
Ethernet s
The MCU core system of Gowin_EMPU_M3 interacts with Ethernet block through
N AHB bus.The Ethernet block is a fully verified black, which can implement
e Ethernet MAC layer function and provide RGMII/GMII/MII interface to connect to
= ifes PHY IC. The block implements MAC layer protocol.
S .
| Gsfee
S
— s e i
o Options
fer
[
Sl it Enable Ethernet
e
s
b e e Interface: RGMII  ~
o -
L g RGMII Input Delay:
g . .. <
MIIM Clock Divider:
.
— o
-
o

e
DDR3 Bt &

MdrFTHF DDR3, AJ LLizAcE DDR3, Wi 3-13 fiox.

i $i%#% Enable DDR3, Il Gowin_ EMPU_M3 37+ DDR3 Memory,
BRIN T 6

DDR3 P #iEf £ 45i 150MHz.

DDRS3 it [T DDR_CLK_| 47543 N 50MHz i Bh 4 .
3-13 DDR3 B2 &

DDR3 ? X
DDR3 &

The MCU core system of Gowin EMPU_M3 interacts with DDR3 block through
AHE bus.The DDR3 block provides a complete solution for customers to use
DDR3 memary. This block located between the DDR3 memory and the user

logic include with Gowin Memory Controller and Physical interface, reduces
the user's effort to deal with the DDR3 memary command interface by
providing a simple generic system interface to the user

Optians

Enable DDR3

IR EREEREREERERREE AR AR RARERARRAER]

Cancel
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SPI-Flash B0 &
SPI-Flash 3 #5F M #ThRE, M Memory 2. 5. #ERIIAE.
4T H SPI-Flash, wULEFECE SPI-Flash, il 3-14 Frox.
ik Enable SPI-Flash, ] Gowin_EMPU_M3 % ¥} SPI-Flash, Bt
ML RE
[#] 3-14 SPI-Flash Bt &

% SPI-Flash ? X
R
SPI-Flash %1
The MCU core system of Gowin_EMPU_M3 interacts with SPI-Flash black
- through AHB bus.The SPI-Flash block is a fully verified black which can be as
i Gowin_EMPU_M3's chip-off running memory. The SPI-Flash block is SP1
™ interface.
B .
.
s
e
el s
e
o
e
iy Options
o fas
e Enable SPI-Flash
.
e
e e
.
o e
s
e
es
- fow
e
P—
.
AHB2 Extension BCE

X477 AHB2 Extension, 7] PLIZ#EAC & AHB2 Extension, 41 3-15
TR

R %&£ Enable AHB2 Extension, ] Gowin EMPU_M3 37 £F AHB2
Extension, H /7 R]DAFEILHE: O BATEREY R AHB Ah &, BRIACH .
3-15 AHB2 Extension ft &

' AHB2 Extension ? X

AHB2 Extension oo

The MCU core system of Gowin_EMPU_M3 interacts with AHB2 Extension
block through AHBE bus.The AHB2 Extension black is a fully verified block
which can extend AHB bus to user to design more AHB peripherals.

Options

Enable AHB2 Extension

IPUG923-1.1 18(27)
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3.2.3 APB Bus System ECE

APB Bus System T &4t B £ 1L,

n# 3-3 .

% 3-3 APB Bus System B & i%IR

P B % I

ik

Enable UARTO

firRgsR 11 0
BRI G ]

Enable UART1

flEgEH 1 1
BRIA KM

Enable Timer0

i REE I 25 0
BRI G ]

Enable Timer1

LR
BRI G ]

Enable WatchDog

fEREE T
NN

Enable RTC

fiife RTC
BRI K]

Enable I12C Master

{§ifiE 12C Master
LN S %]

Enable SPI Master

f§ife SPI Master
BRI\

Enable APB2 Extension

ffigE APB2 ¥ B4 11

UART B &

M7 UARTO 2 UART1, wLUL#EACE UARTO 2 UART1, 41

3-16 flrr.

® Uitk Enable UARTO, | Gowin_EMPU_M3 37 UARTO, BRil>%

il
\ . 4 Ny Y
® I %k#* Enable UART1, Il Gowin_EMPU_M3 % #f UART1, ERil%
\
il
3-16 UART it E
UART ?
UART 55
The MCU core system of Gowin_EMPU_M3 interacts with UARTO/1 block
e through APB bus.The UARTO/1 block is a fully verified block which can
P implement UART communication. UARTO/1 block cantains two universal
P asynchronous receive/transceiver, which support maximum baud rate at
. R 921.6Kbit/s.
e
B
11267 e
] s [
11205 L
1R
e .
len Options
i .
o Enable UARTO
5 [ Enable UART1
<
| AT D 7l
il
o -
2 e

IPUG923-1.1
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Timer B0 E

W4T T Timer0 5 Timert , o LI+ Timer0 5 Timer1, il 3-17
BT«

® {31kt Enable Timer0, Il Gowin_ EMPU_M3 37 £f Timer0, Bk il 5% 1.
® {31kt Enable Timer1, Il Gowin_ EMPU_M3 37 £f Timer1, BR il %M1
& 3-17 Timer Bt &

o Timer [4 X
Ti N
imer )
The MCU core system of Gowin_EMPU_M3 interacts with Timer0/1 block
. . through APB bus.The Timer0/1 block is a fully verified block which can
"_ N implement counter function. The Timer0/1 black contains two Timers, which
e support 24-bit counter.
1 1 -
— . .
s s
1 6
0 1 -
e R
s &
1 4 b
s i Options
1 b
— | TR
G 12 [ Enable Timer0
11
RN e Enable Timerl
— T G 1 -
1 %
s 1 b
s 15
Gowin EMPU M3

WatchDog B E
M idi$T H+ WatchDog, 7] LLiE$#EALE WatchDog, 41 3-18 Fiws
5% £ Enable WatchDog, ] Gowin_ EMPU_M3 3 ## WatchDog,
BRAIN KT o
& 3-18 WatchDog B &

% WatchDog ? X

WatchDog &

The MCU core system of Gowin_EMPU_M3 interacts with WatchDog block
through APB bus.The WatchDog black is a fully verified black which can
implement system reset when system is running over.

— s
e Options
e
oG 2

I Enable WatchDog

EEEEEEEE AR EEEE R RN

Gowin EMPU M3

IPUG923-1.1 20(27)
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RTC BL &
XHATTF RTC, Al LUEFELCE RTC, @i 3-19 Fivk.
R % Enable RTC, I Gowin_ EMPU_M3 3 #f RTC, ZRiIAIEH].
i 1 RTCSRCCLK #2 A 3.072MHz s &hig A, RTC W #4048 1Hz.
3-19 RTC B. &

% RTC ? X
RTC &
The MCU core system of Gowin_EMPU_M3 interacts with RTC block through
o APB bus.The RTC block is a fully verified black which can implement real time
clock.
TE0 [

R PP

i 1 s
e 6
a5

Bt 18 10 Options
BT TS
62 | Enable RTC
1 12

—a]axs s e
1 T el
1
T8 1 -
T8 16 -

Gowin EMPU M2

I12C Master L &

XTI 12C Master, 7] LLERRCE 12C Master, 41K 3-20 fiir.

15 %$% Enable 12C Master, ] Gowin_EMPU_M3 3 #F 12C Master, 2k
N
3-20 I2C Master Bt &

' 12C Master 7 X
12C Master o
The MCU core system of Gowin_EMPU_M3 interacts with 12C Master block
. through APB bus.The 12C Master block is a fully verified block which can
R implement 12C communication. The 12C Master block implements 12C
P protocol.
7354
735 o
706
— 7567
7 =
I7ac 5
et i Options
1 -
IRG.12 e Enable 12C Master
e
— 1
a5
-
12
s
5

Gowin EMPU M3
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SPI Master B0 E

4T H SPI Master, 7] LLIEFC & SPI Master, 41K 3-21 s
ik FE Enable SPI Master, ] Gowin_ EMPU_M3 32 ¥F SPI Master, %X
KM
3-21 SPI Master Bg &

' SPI Master ? X
SPI Master o
The MCU core system of Gowin_EMPU_M3 interacts with SPI Master block
N through APB bus.The SPI Master block is a fully verified block which can
e implement SPI communication. The 5P Master block implements 5Pl protocal.
0
1565 e
—
1
156 T b
LT S
156 b
e
— i mac o
T Options
P
L i Enable SPI Master
.
o
—
s 7
TTaG 12 -
wen -
s
s
Gowin EMPU M3
Cancel
APB2 Extension BCE
W11 7T APB2 Extension, ] DL E APB2 Extension, 1[4 3-22 iy

ﬂ—\‘o

Rk $E Enable APB2 Extension, Jll Gowin_EMPU_M3 3. #F APB2
Extension, F /o] DIESLE: O HATIEEY R 1) APB 4%, BRI .
3-22 APB2 Extension fic &

" APB2 Extension T X
- i
APB2 Extension 57
The MCU core system of Gowin_EMPU_M3 interacts with APB2 Extension black
. : through APB bus.
ke The APB2 Extension block is a fully verified block which can extend APB bus to
.l o user to design more APB peripherals.
- S -
.. -
e
- N
.
(s
-
.
e Options
-
. Enable APE2 Extension
- .
.
.
— -
e
.
N
o
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3.3 APt

® 5t Gowin_EMPU_M3 it & 5, 7=k Gowin_EMPU_M3 fE#F 151t

® :fi{k Gowin_EMPU_M3 Top Module

o S NABIT, #EH: Gowin_ EMPU_M3 Top Module 5 f v %
i, TERGEEEN RTL ¥t

3.4 43R
SERCH P RTL Wit f5, AR FH B Al RN 75 B N fn B 1) 10, 722k
YR 2 A,
MR P B SR, PR 2K S0 .
YRR R AT, iE5% SUG101, Gowin it ki85 .

3.5 i E

3.5.1 ZFHIAMALE
LM AR, i 3-23 Fis.
® RIFEW IS PRTZ AR AL FREC E Top Module/Entity:;
® RIEE I I SE bR AR EL A Include Path;
® [ii& Verilog Language, 1 System Verilog 2017

B 3-23 THEIRREC E
W Configuration x
Synthesize
General Genera |
v Synthesize Synthesis Tool: ®) GowinSynthesis
EErEE ] Top Module/Entity: |Gowin_EMPU_M3_temp|atB |
v Place & Rout

Cenera | Include Path: | |
Unused Pin GowinSynthesis
Dual-Purp Pi
BitStream Verilog Language: System Verilog 2017 -
VHDL Language: | VHDL 2008 v
Looplimit: 2000 -

[] Disable Insert Pad
Ram R/W Check
[] D5P Balance

[ Show All Warnings
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3 TR 3.6 75

3.5.2 Dual-Purpose Pin B &
Gowin_EMPU_M3 fi ff] /41 SPI-Flash F#53h 75, &/ MSPI i 1
A, i 3-24 B,
3-24 Dual-Purpose Pin fg &

W Configuration X

Dual-Purpose Pin

General [ Use JTAG as regular 10

~ Synthesize
Use S5PI as regular 10

General

v Place & Route Use MSPI as regular 10
General [ Use READY as regular IO
Unused Pin

[] Use DONE as regular 10

Dual-Purpose Pin
. [[] Use RECONFIG_N as regular 10
BitStream

[] Use MODE as regular 10

Use 12C as regular 10

Cancel Apply

1547 Gowin =R K454 T H GowinSynthesis, 58/ RTL ¥t 4E
G, HERMRMRSCAE, W 3-25 Fis.
3-25 Z&

e i syaprbaml] - o x

Synthesis Messages

Design Fle

GowinSynthesis Constraints Fis

2 17:13:0 2021

Logal Announcemen Conyright (€12014-2021 Gown Semkanductar Corporation. ALL rights reseryed.

Synthesis Details

Top Lavel Moduls

e — -y e, seupis i s g plle el s T

1\ Fpga_reé_design\OK_START_GH2ASS_V1.3\gouln_sepu_u3\inpl\gusynthesis\gan
(foga_ref_design\DK_START_GMZASS V1. 3\gowrin_empu_w

g TRMEHTNE, 152% SUG100, Gowin =iEHAH F 46w -
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3 TFERAR 3.7 ARk

3.7 Atk
24T Gowin = IR An e 26 T A Place & Route, 5SERAf JRifi 4k,
A S S, aniE 3-26 Faw.
& 3-26 Place & Route

»»»»»

PnR Messages

PnR Details

fif/mAi sk T EAEH 51, iE5% SUG100, Gowin =YR#AEH F 465 .
3.8 T#;

1z4T Gowin Z=IEIKAE K R #4kF Programmer, 58 RS SO T 3o

#1157 Programmer 32 5.4%“Edit > Configure Device "8 T. E.£ Configure
Device “ 4 7, #TFF Device configuration.

® Access Mode THi%%, ##F “External Flash Mode” %5,

® Operation FHi41%, £ “exFlash Erase, Program thru GAO-Bridge”
o “exFlash Erase, Program, Verify thru GAO-Bridge” £ 1ii;

Programming Options > File name &1, S\ 72 TR H SO

External Flash Options > Device &£, HR#EFF &Mtk Zk Flash its 28
R oI RARAR 2, Winbond W25Q64BV);

External Flash Options > Start Address &1, FEZ&E A “0x000000”;
¥y “Save”, ¥l 3-27 Fis.
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3 TFERAR 3.8 T#

& 3-27 T

4 Device configuration ? X
Device Operation
Access Mode: External Flazh Mode A

Operation: exFlazh Erase, Frogram thru GAO-Bridgze -

exFlash Erase, Frogram thru GAD-Bridge

Frogramming Options

File name: |[WRT_GWZARS_V1.3/zowin_empu_m3/impl/pro/gowin_empu_m3. f= | D

User Flazh Initialization

External Flash Options

Tlevice: Winbond WEBQG4EY -

Start Address: 0000000

Save Cancel

56 /% Device configuration J5, i Programmer T. Hf=
Program/Configure “ “0 7, SE AR F#k.

N# L H Programmer i f /71%, 15%% SUG502, Gowin Programmer
P $aF
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4 ZH BT

7 Y-

Gowin_EMPU_M3 2 27 it
Gowin_EMPU_M3\ref_design\FPGA_RefDesign
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